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Overview of the MTI Administration Process
Application Process
The MTI Program application process is completed online in the ISAC Student Portal: at
https://studentportal.isac.org/.
Applicants must create an ISAC Student Portal Account to complete the online application. The
Application/Promissory Note may be signed and submitted electronically, which is the preferred
method, or they may print and sign the application by hand and mail to ISAC’s Deerfield office.
Paper applications must be submitted with an original ink signature and cannot be submitted via
e-mail or Fax.
For priority consideration, ISAC must receive a complete application on or before March 31
preceding the academic year for which the applicant is applying.
RISE Act-Eligible Applicants

Applicants who indicate on the application that they are not a citizen or eligible noncitizen, but
may qualify for MTI through the RISE Act, which allows undocumented students to apply for
Illinois financial aid, will have to certify that they meet the RISE Act criteria.
In order to complete the MTI application, these students must complete an Alternative
Application Student Profile if they have not already done so. Through this process, ISAC
assigns a unique student identification (ID) number to the student, which is in format similar to a
Social Security Number (SSN). The ISAC ID number will remain the same for the student each
year that the student continues to receive benefits from the MTI program, and would also be
used for any other ISAC programs for which the student may apply.

Students who may have applied for MAP using the Alternative Application prior to completing
an MTI application should use the ISAC ID number assigned to the student during that process
for all other ISAC program applications, including MTI.
For more information on RISE Act eligibility criteria, visit:
• www.isac.org/students/before-college/financial-aid-planning/retention-of-illinois-rise- act/
For more information on MTI eligibility information:
•
https://www.isac.org/isac-gift-assistance-programs/mti-scholarship/eligibilitymti.html
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Overview of the MTI Administration Process
Certification
The next step in the process is for colleges to complete certification for each MTI applicant listed in
GAP Access. A complete application (submitted by the student) and a complete certification record
(submitted by the college) are required to be considered for an award.
The Student Certification List in the MTI system includes all applicants in the three categories
listed below:
• Renewal Timely Applicants (received/postmarked on or before March 31)
• New Timely Applicants (received/postmarked on or before March 31)
• All Untimely Applicants (received/postmarked on or after April 1).
All certifications must be completed regardless of whether the applicant is eligible or ineligible.

If a college certifies an applicant as ineligible for an award, a Notice of Ineligibility is sent to the
applicant. Copies of ineligible student letters are not sent to the college. If a student subsequently
meets the eligibility criteria, the certification can be corrected in GAP Access and resubmitted. If a
student becomes ineligible after eligibility has been established, the student will receive a Notice of
Disqualification.
Award Determination
The total number of scholarships awarded each year is contingent upon the amount of funding
appropriated by the Illinois General Assembly, and the awarding process does not occur until after a
final appropriation has been approved by the General Assembly and the Governor.
All timely, certified applicants are considered in the initial awarding.
When appropriated funds are insufficient to provide scholarships for all qualified applicants,
available funds will be awarded to qualified students who submit complete timely applications based
on the following priority order:
• Scholarships will first be awarded to renewal applicants.
• If funds remain after qualified renewal applicants have been awarded, then at least 35% of
appropriated funds will be reserved for qualified male applicants, with priority given to
qualified Black male applicants.
• When the appropriation reaches specified thresholds, funds are reserved for qualified
bilingual minority applicants, with priority given to those enrolled in an educator
preparation program with a concentration in bilingual, bicultural education.
• If funding is insufficient to award all qualified applicants within any of the priority
categories above, then awards within that category will be prioritized as follows:
o to students who demonstrate the most financial need
o to students with the earliest date of received complete applications, and
o to qualified applicants enrolled at or above the junior level.
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Access and Navigation
The system to administer the Minority Teachers of Illinois (MTI) Scholarship Program is available
through ISAC’s Gift Assistance Programs (GAP) Access portal at https://isacportal.isac.org.
All users need a valid GAP Access ID and password to access the system.
ISAC relies on a designated Primary Administrator (usually, the Financial Aid Director) at each
institution to authorize users and provide them
with the appropriate level of access for each
ISAC program.

Once a school user has successfully logged in to
GAP Access, the MTI information can be accessed
by selecting the MTI program near the top of the screen.

Please note that the GAP Access system will time out after prolonged inactivity. The following
message will appear to allow you to save your data.
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MTI Student List Eligibility: View Screen
Once you have navigated to the MTI Program in GAP Access, you can view the list of students who
have submitted an MTI application to ISAC and listed your school as the college the applicant plans
to attend. The list will initially appear in alphabetical order, however, you may use the Filter, Sort
and Columns functionality to customize your view as needed.
In addition to the applicant data, the Student List Eligibility: View screen includes the application
receipt date, application status, and icons to indicate eligibility issues.
Applicants with eligibility or conflict issues will be identified by icons in the List view, and more
information can be obtained on the applicant’s Student Detail screen by selecting the magnifying
icon
in first column of the student record.
A yellow lightbulb
is an indicator of student eligibility issues, and a red triangle
indicator of a conflict issue.

is an
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MTI Student List Eligibility: View Screen

Students who have a Bilingual Certification
are identified with a “Y” indicator or an “N”
indicator.

Depending on your computer, monitor, and screen settings, you may need to use the horizontal
scroll bar at the bottom of the page to navigate farther to the right to see the remaining columns on
the Student List Eligibility: View screen.
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MTI Student List Filter Screen
You may filter student records by selecting specific categories provided on the Student Eligibility
List: Filter screen, which can be accessed by selecting the Filter tab.

Once you have selected your criteria from the drop down menus and/or selected the category
options on the right side of the screen, select the List tab (located to the left of the Filter tab) to
generate your customized view.

A Reset tab is also available to clear multiple selections with one click.
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MTI Student List Sort Screen
The Student Eligibility List: Sort screen provides you with several options for sorting the student list.
This screen is accessed by selecting the Sort tab.
To sort your list, check the box next to the the data element(s) you would like to sort by, then select the
Add arrow to add them to the Selected list.
Use the Move Up arrow

to put the data elements in the order in which would to sort.

You can also drag and drop your selection(s) into the Selected or Unselected column.

Selected checkboxes will be sorted descending. Unchecked checkboxes will be sorted ascending.

Once you’ve made all of sorting selections, click on the List tab (located to the left of the Filter tab)
to generate your customized list.
A Reset tab is available to clear multiple selections with one click.
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MTI Student List Columns Screen
The Student Eligibility List: Columns screen allows you to select the columns you want to view and
customize the order in which they appear. This screen is accessed by selecting the Columns tab.
To select a Column for your customized list, click on the column heading to highlight it and then the
Add arrow to add it to the Selected list.
Similarly, to remove a column from the List view, select the Column heading in the Selected list and
then click on the Remove arrow to add it to the Unselected list.
Use the Move Up and Move Down arrows to put the columns in the order in which would like
them to appear on the List screen.
You can also drag and drop your selection(s) into the Selected or Unselected column.

Once you’ve made all of selections, click on the List tab (located to the left of the Filter tab) to
generate your customized list. A Reset tab is also available to clear multiple selections with one
click.
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MTI Certification List: View Screen
The Certification List: View screen includes all applicants for whom ISAC has received a complete MTI
application with your college listed on the application.
Certification is the first step in the awarding process and requires that colleges complete and submit the
certification record for each applicant, regardless of whether the student is eligible or ineligible. The
only way an applicant can be considered for an award and/or receive an MTI notification letter about
their ineligibility is if the applicant’s certification has been completed by the college in GAP Access.
To complete a certification record for an applicant, navigate to the Certification List screen and click
on an individual student’s name or SSN to open up a Certification Data screen for the student. Enter
the required data and then click on the Save/Submit button to complete the certification process for
that student record. The Save/Submit button will not be enabled until data has been provided for all
required fields. Or, to exit without saving and submitting, click on the Close button.

Student Name

Once a certification record has been saved, it will be considered submitted and will no longer appear
on the Certification List: View screen. If something changes with a student’s eligibility prior to the
awarding process, corrections can be made to the certification record in GAP Access. Certified
applicants will continue to appear on the Student List Eligibility: View, and the Certified Eligible
field will be populated with a Y or an N depending on how the certification was completed.
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MTI Student Certification Data Screen
Once the Certification Data screen has been opened up for an individual student record, the
certification process can be completed by entering the appropriate data.
In the first data field, you must indicate if the student is eligible by selecting “Yes” or “No.”

The answer to this question will determine the other data elements that must be completed on the
screen to complete the Certification process. Required data fields will be outlined in red.
If the answer is “No,” the required field you must complete is Ineligible Reason by selecting the most
appropriate answer from the drop down menu.
After providing data elements for the required field(s), click on the Save/Submit button to complete
the process.
Once you’ve saved the data, the student’s certification is complete, and the student will no longer
appear on the Certification List screen.
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MTI Student Certification Data Screen
If “Yes” is selected for the Eligible field, you must provide the following:
•
•
•

•
•

Academic Level -- Provide the student’s academic level for the upcoming award year
Anticipated Terms -- Provide the student’s anticipated term(s) of enrollment
Is the student bilingual – Yes or No
o If the student is bilingual, you must provide
▪ Bilingual Type
▪ State Seal of Biliteracy
▪ Passed education license proficiency test
▪ All of the above
▪ Bilingual Program
▪ Bilingual educator preparation program
Career Pathway Endorsement -- Yes or No
EFC -- Schools should report the EFC from the valid ISIR on which a student’s financial
aid would be based, as of the date that the MTI certification is completed.

After you’ve made your entry selections, the information boxes will remain outlined in red until you
have saved the information entered on the page, which is done by clicking on the Save/Submit
button at the bottom of the page. Once you have saved your entries, they are considered submitted
and certification is complete.
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MTI Certification Data Definitions
Qualified Bilingual Minority Applicant
A qualified bilingual minority applicant is one who demonstrates proficiency in a language other than
English by receiving:
o a State Seal of Biliteracy from the State Board of Education, or
o receiving a passing score on an educator licensure target language proficiency test.

State Seal of Biliteracy
The Seal of Biliteracy is an award given by a school, district, or state in recognition of students who
have studied and attained proficiency in two or more languages by high school graduation.
Illinois provides two awards: Seal of Biliteracy for those with a "high level of proficiency" - for most
languages, this level is Intermediate High (4/5 on the AP Exam). A secondary award is the
Commendation Toward Biliteracy (Intermediate-Low).

Students must meet the language proficiency criteria in both English and the second language. The
second language may be a home language, learned in school or through travel or outside means.
Schools can find the State Seal of Biliteracy on both the student’s diploma and transcript. Illinois state
universities, by state law, are required to provide university credit for Seal recipients.
For more information on testing and recognition information, visit the ISBE Seal of Biliteracy page
https://www.isbe.net/Pages/Illinois-State-Seal-of-Biliteracy.aspx

Career Pathway Endorsement
Pursuant to Section 80 of the Postsecondary and Workforce Readiness Act, school districts may award
College and Career Pathway Endorsements to high school graduates. Students earn endorsements by
completing an individualized learning plan, a career-focused instructional sequence, and professional
learning opportunities. The endorsements incentivize career exploration and development, particularly
in high-demand career fields.
To earn a college and career pathways endorsement, students will have followed an individualized
learning plan, career-focused instruction, career exploration activities and 60 hours of supervised
career development experiences.
For more information:
o https://www.isbe.net/pathwayendorsements
o https://media.advanceillinois.org/wp-content/uploads/2014/11/04001239/Facts-aboutHB5729-FINAL.pdf
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MTI Certification List: Filter Screen
A filter functionality is available in the Certification section that will allow you to select certain
records for certification if you prefer to complete them in a particular order.
For example, if you prefer to focus on a certain academic level first or on all timely renewals
first, you may select those options on the Certification List: Filter screen, and then select List to
generate a filtered list.
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Updating/Correcting an MTI Certification Record
If something changes with a student’s eligibility prior to the awarding process, corrections can be
made to the certification record in GAP Access.
To access the student record to make a change after it’s already been certified and submitted,
navigate to the Certification List: Filter screen and filter for the student using any of the available
options shown below.

When using the filter options, be sure to
select the appropriate Certified Status for
the record(s) you are wanting to access,
or simply select All for the Certified
Status option.
If your filtering options do not initially
provide the result you’re looking for,
check to make sure that an option has
been selected for the Certified Status and
that it has not been left blank.
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Suggestions for Using Filter, Sort and Columns Functions
To Identify Certified Records
• The Certification List View default view is for records that have not been certified. The certified
status will show as blank “not yet certified:. The records that are blank in the certified status are
outstanding certifications.
• If you would like to see a different group of students, you can select a different certify status to
get the record to display. The options that can be filtered are:
• All
• Eligible
• Not Eligible
• To see all the students, you will have to filter the student by All under the Certified Status

To filter students by Certified Status:
•
Go to the Filter tab.
•
Click on All under Certified
Status.
•
Click on the List tab to view your
list of students.
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Overview of the MTI Payment Process
MTI payment processing is done using the MTI system available through ISAC’s Gift Assistance
Programs (GAP) Access portal.
MTI eligibility and payment processing can be accessed by selecting MTI under the Programs tab
near the top of the screen once the school user has successfully logged into GAP Access. Program
functions are contingent upon each user program privileges. The administrator must access the
User Maintenance area and update the program access and level for each user.
– “None” will grant you zero access to MTI data.
– “Update” will grant you the ability to both edit and view MTI data.
– “View” will grant you the ability to only view MTI data (i.e., no editing ability).

After completing the payment request process in GAP Access, payment is made to colleges
through an offset process. As part of this process, new payment requests are compared to
outstanding amounts owed to ISAC, and payment is made accordingly. This system was developed
to accommodate the many changes in student eligibility that can occur during the awarding and
disbursement of financial aid (including decreases, increases to awards, initial requests, and full
refunds). Therefore, funds should be returned to ISAC only after a final reconciliation has been
completed at the end of the regular school year. All schools with an outstanding amount owed to
ISAC at the end of the school year will receive a notice indicating the total amount to be returned.
Information about the payment offset process and reconciliation is located on the Refunds and
Unpaid Claims page in the Processes area of the FAA section at isac.org.
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MTI Student Payment List: View Screen
The Student List Payment: View screen gives the user the ability to easily select students to view
payment-related items such as payment request amounts, payment result amounts, and payment result
codes at a glance. It operates like the Student List Eligibility: View screen, allowing the user to
select students who are attending their school and to filter and sort the list according to specific
criteria.
The initial loading of this page will result in a default view with the following columns:

•
•
•
•
•
•
•

Sel (Select)
Req Sel (Req Select)
Term
Current SSN
Last Name
First Name
Annual Award

•
•
•
•
•
•
•

Requested Amount
TermAward
School Code
Request Code *
Enrollment Status *
Ineligible Reason *
Amount Paid

•
•
•
•
•
•
•

Adjusted Amount
Result Code*
Expanded Result
Result Date
Status Code *
Invoice Number
Awarded GA

* All codes can be found at the end of the user guide.
Schools can create a customized Student List Payment: View screen by selecting specific
columns to be viewed, as well as use data sorting and filtering.

The Student Payment List: View is accessed by selecting the Payment tab. The following
functions are available on the Student List Payment: View screen: View, Filter, Sort, Columns,
Payment Request Entry, and Submit Payment Requests.

September 2021
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Student Payment List: View Screen

Check the boxes in the Req Sel column to select students for payment.
Save your selections by clicking on the Save Selected button at the bottom of the page.
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Student Payment Eligibility List: Filter Screen
The Filter screen provides many different options for filtering the Student List Payment: View
screen. Users can change the records to be viewed on the Student List Payment: View screen
by setting specific criteria for one or more of the options on the Filter screen.

For the Ineligible options, if more than one is checked a record must meet all conditions to be
included in the filtered view.
Click on the Reset button to reset the data to the default values.
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Student Payment Eligibility List: Sort Screen
This screen allows the user to sort the designated columns on the Student List Payment: View
screen by something other than the defaulted view of sorting by last name.
For example, the user may select to sort by Enrollment Status. To do so, highlight the column title in
the Unselected list of options and click on the arrow pointing
to the right.

This will add it to the Selected columns. Then, use the up arrow to move Enrollment Status to the
top of the Selected columns. Click on the View tab and you will see a list sorted by Enrollment
Status. If the checkboxes next to the Selected columns are checked, the list will be sorted in
descending order. If the boxes are left unchecked, the list will sort in ascending order.
To remove a column from the Selected sort list, highlight the column title and then click on the
arrow pointing to the left to move it to the Unselected list.

To move all Unselected columns to the Selected list, click on
To clear the entire Selected list, click on
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Student Payment Eligibility List: Columns Screen
This screen allows you to select which columns will be displayed on the Student List Payment:
View screen, and the order in which they will appear.
To add columns to the Selected list, highlight the column title in the Unselected list and click the
right arrow to send it to the Selected list. To remove a column from the Selected list, highlight it
and click the left arrow to move it to the Unselected list.
If you want to re-arrange the columns once they are selected, highlight the desired column and
move it by clicking on the up or down arrows until it is in the desired location in the list.
When you click on the View tab, the columns will display in the order in which they appear in
the Selected list.
To move all Unselected columns to the Selected list, click on

To clear the entire Selected list, click on
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Student Detail: Payments Screen
Individual Payment Requests
The Student Detail: Payment screen is a multi-purpose screen that allows schools to view
payment information or to create or make adjustments to payment requests for an individual
student record. This screen is accessed by clicking on the dollar sign icon that is on the same line
as the student’s last name on the Student List Payment: View screen and by selecting the
Payment tab from the Student Detail: Eligibility screen.

In addition
navigation
–
–

to the Payment tab, the Student Detail: Payment screen contains the following
tabs:
List – to return to the Student List Payment: View screen
Eligibility -- to navigate to the Student Detail: Eligibility screen

To navigate to
another student,
enter the student’s
SSN in the
Current SSN
field and click on
the Go button.
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Student Detail: Payments Screen
When requesting payment from the Student Detail screen, there are three required fields:
•
Request
•
Enrollment Status
•
Requested Amount (To adjust the system-calculated annual award amount if necessary)
– The current award amount is up to $5,000 per year.
‒ It is subject to appropriation.
‒ If appropriation increases, annual award amount may also increase.
Each of these fields must be completed with the appropriate information for payment requests to be
processed properly. If the student is ineligible an Ineligible Reason must be selected and a zero ($0)
should be entered in the Requested Amount field. Click on the Save Changes button to save the
payment request, or the Discard Changes button to discard the payment request.
Note: The payment request process is not complete until the next step of submitting the payment
requests to ISAC has been completed using the Submit Payment Requests screen.

Select:
Payment-to request
a payment

Cancel-to cancel a
previously requested
award
Ineligible-to be
completed for
students who are
ineligible
Delete-to remove
the payment request
before submitting
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Student Detail: Payments Screen

MTI Ineligible Reason Select the appropriate reasonthat
makes the student ineligible.
• Not enrolled *
• Not a US citizen/eligible non-citizen
• Not an Illinois resident
• Not a HS grad/no GED
• Defaulted student loan
• Conflicting scholarship
• Not making satisfactory academic
progress
• Reached max number of years
allowed
• Not a minority
• GPA not at least 2.5 on 4.0 scale
(soph or above)
• Not enrolled at least half-time *
• Student is not accepting MTI
• Not enrolled in a teacher program

* If an Ineligible request is submitted, all payment for
the term will be canceled, unless it is for the reason “Not
enrolled” or “Not enrolled at least half time” in Semester
1 or Quarter 1 or 2.
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Payment Request Entry
Batch Payment Request
When creating benefit requests for a large number of students, the best option is to do a batch
request, which is done by selecting students from the Student Payment List: View screen.

The first step on the Payment Request Entry screen is to select the appropriate academic term
using the drop-down box in the Term field (initially blank) for which you will be creating payment
requests.
A list of your selected records will not display until you have selected a term.

Once a term has been selected, the list of students you selected on the Student Payment List View
for that term will be provided, and you can then begin to enter payment information.
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Payment Request Entry

To complete the payment request for each student, enter the required data into the appropriate
fields:
•
Request – Select the appropriate item from the drop-down menu options:
– “Payment” to create a payment request
– “Delete” to delete a request that has been created but not yet submitted
– “Ineligible” to make a student ineligible
– “Cancel” to cancel a previously requested award
•
Enrollment Status – Enter full time or half time status
•
Ineligible Reason - If the student is ineligible an Ineligible Reason must be selected and a
zero ($0) should be entered in the Requested Amount field.
– Note: If an Ineligible request is submitted, all payment for the term will be canceled,
unless it is for the reason “Not enrolled” or “Not enrolled at least half time” in
Semester 1 or Quarter 1 or 2.

•

Click the Save button to save your data before navigating to a new page.

•

As a reminder, the payment request process is not complete until the next step of submitting
the payment requests to ISAC has been completed using the Submit Payment Requests
screen.
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Submit Payment Requests Process
The Submit Payment Requests screen allows the user to submit payment requests to ISAC for
processing. The user can specify which payment request records will be submitted based on Term
selected.
This screen is accessed by selecting the Submit Payment Requests tab.

After payment requests have been submitted by clicking on the Submit button a message will be
displayed indicating how many payment requests were submitted
To submit payment requests to ISAC for MTI payment follow these steps:
– Choose the Term for which the request is being made from the drop-down menu.
– Click on the Submit button to submit the payment request.
– Ensure that a submission message is received and make note of the number of records
submitted.
.
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Payment Reports
All payment results can be obtained at various stages in the payment request process through
system-generated reports. To create a report, navigate to the Reports tab, and then click on the
Create New Report

The Select Report drop down menu is displayed below. To select a report, highlight the title and
click on the Request Report button. Data range fields will then be provided to allow you to
enter start and end dates for the report. The date fields are optional fields, and if left blank, the
report will be cumulative.
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Payment Reports
After requesting a report, you will be returned to the Reports screen where a list of reports that
have been or are being generated for your school will be provided.
While the report is processing, the status will indicate In Queue. The refresh button completes the
report. When it is ready, the status will change to Completed. To open the report, click on either
the Microsoft Word or the Microsoft Excel icon. Additional information about the report,
including the date, file size and user name of the person who requested the report will also be
listed.
Reports displaying the pdf icon
are ISAC-generated reports and identifiable by the user
name MTIInvoice in the last column of the report list. Typically, this report is made available on
the next business day after your school’s payment request has been processed and will remain
available if space allows. It is suggested that you save requested and ISAC-generated reports to
your systems for future reference.
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Payment Results Summary/Invoice Detail
A Payment Results Summary and Invoice Detail Report is generated by ISAC after your school’s
payment request has been processed. It will include a Payment Results Report and a Payment
Exceptions Report, as well as Invoice Detail about the payment claim. Typically, the report will
be provided in the Reports Section on the next business day after the request has been processed
by ISAC. This report is needed to match the voucher/invoice number and payment.
The Payment Results Summary and Invoice Detail will appear on the report list and can be
identified by the pdf icon
in the first column and the user name of MTIInvoice in the last
column.

The last page of this report provides invoice information, including amount due to the school and
the invoice number. ISAC authorizes a voucher in the amount of the payment invoice and
submits it to the State Comptroller’s Office which issues payment to the institution. Vouchers are
emailed to the Financial Aid Director. The invoice number will be referenced on the voucher
authorizing payment from the State Comptroller. Colleges can match the invoice number on the
Payment Results/Exceptions report with the voucher.
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MTI Codes
Result
Code
K
F
4
J

Expanded
Result Code

G
G
H
U

Y
P

Q

Y

Q
R
R

T
Y
P

Reason

Ineligible for payment due to due to ISAC Default
Full MTI units already used
Request superceded by another request
Ineligible for payment due to calculated award amount of zero
Full annual award amount already used
Full program award maximum already used
Previously paid to your school for requested term
Cancel requested; no prior payment has been made for this
term
Ineligible reason processed - not eligible for this academic year
Ineligible reason processed - not eligible for this term
Payment reduced to maintain MTI annual award amount limit
Payment reduced to maintain MTI program maximum award
amount
With this payment student attains the maximum number of
terms. Student will no longer be eligible for MTI payment

T

B

Payment increased

C
*

Payment decreased
Payment processed - no reported exception
Y= Annual maximum
P = Program maximum
T = Term maximum

Request Code
P

Definition
Payment

C

Cancel

I

Ineligible

D

Delete

Status Code

Definition

U

Updated

S

Submitted

P

Payment

Enrollment
Status Code
H
F

Definition
Half-time
Full-time
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